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MASH App Release Notes 

MASH Native 1.0.1                                                                             April 22, 2022 
MASH Native 1.0.1 has a critical bug fix to 1.0: 

• Fixed a bug in the new internal fragmentation code that caused display of fragment ion assignments in 
the Sequence Table to fail. 

 

MASH Native 1.0                                                                                  April 6, 2022 
MASH Native 1.0 builds on MASH Explorer and introduces a number of new features: 

• Added spectral summing capabilities with multiple summing options and MS scan selection strategies. 
• Added the ability to display internal fragments found during deconvolution. 
• Added the option to display a heatmap of sequence coverage. 
• Added a Da spectrum view for spectra that have been charge state deconvolved using UniDec with 

Daltons as the X axis 
• Adding a modification with no average mass no longer causes problems. 
• Fixed a bug in handling charge distributions for UniDec. 
• Handling of raw files fixed for both Thermo and Waters files. 
• Added partial support for search-only workflows in discovery mode 
• Added Bruker TDF file support. 
• Added partial support for handling centroided data. 
• Before starting a workflow, MASH now checks the available disk space and warns the user if too low. 
• The configuration dialog now determines whether paths to software are set properly (shown as green). 
• Thermo and Waters data import is supported through vendor DLLs and ProteoWizard. 
• Improved results import when multiple experiments are open. 
• Centroided data is now displayed as a stick spectrum. 
• UniDec parameter interface updates. 
• Number of threads available as a parameter for TopFD. 
• Menu item added for accessing the Application Data folder 
• Support for TopPIC suite 1.5. 
• Limited support for FLASHDeconv (2021-07-24 release). 
• Fixed importing of ASCII files in targeted mode. 
• (Note that MASH Native 1.0 requires .NET Framework 4.8, which is a more recent version than 

previously required.) 
• (Note that, for compatibility reasons, log file and configuration file names have not changed between 

MASH Explorer and MASH Native.) 
 

MASH Explorer 2.2.2                                                                     February 24, 2022 

Version 2.2.2 has some small improvements to version 2.2.1: 

• Added the capability for users to set the Java maximum heap size for workflow tasks. 
• Fixed problems with some of the auxiliary software download links. 



 

MASH Explorer 2.2.1                                                                              July 30, 2021 
Version 2.2.1 has some small improvements to version 2.2: 

• Added support for MS3 data. 
• Fixed a bug that could cause Index Out of Range errors when opening some Thermo .RAW files. 
• Fixed an incompatibility with ProteoWizard 3.0.21193 that caused problems with importing 

experimental data. 
 

MASH Explorer 2.2                                                                             March 8, 2021 
Version 2.2 introduces a number of new features: 

• Added support for UniDec deconvolution. 
• Added support for TopPIC 1.4.0 and later. 
• Added the option to view fragment labels (see the View menu). 
• Added the option to view fitting curves (see the View menu). 
• Added the ability to re-run uploaded workflows. 
• Added the ability to drag and drop workflow parameter files. 
• Added a Workflow Manager button to automatically access workflow log files. 
• Made opening of very large experiment files more reliable and responsive. 
• Fixed problems parsing TopPIC output if the name of the experiment file contains a comma. 
• Fixed a bug that would cause MASH Explorer to crash if you increased the number of workflow threads, 

and then closed and re-opened the Workflow Manager. 
• Added contact/user support information to the About dialog. 

 

MASH Explorer 2.1.1                                                                    December 14, 2020 
Version 2.1.1 fixes two bugs in version 2.1: 

• Fixed a bug that prevented recent (1.3.0 and later) TopPIC versions from working if the generating 
function for E-value computation is enabled.  (Note that there is apparently a bug in TopPIC version 
1.3.5 that prevents it from working if the generating function is not enabled.  We are anticipating a fix in 
a future TopPIC version.) 

• Fixed the following bug: when the sequence table is generated from a match, if it has identified a 
modification from TopPIC, an extra amino acid is erroneously added to the sequence. 

 
MASH Explorer 2.1                                                                     November 23, 2020 
Version 2.1 introduces a number of new features. 

• Support for FLASHDeconv. 
• Improved UVPD support. 
• MzML file type supported. 
• Fixed a problem that could cause importing of experiment files to fail if MASH Explorer is running on a 

computer that has its language set to something other than “English (United States)”. 
• Fixed a number of bugs in multiple experiment support (including sequence table not being updated 

when switching experiments and problems importing results from a workflow not running on the 
currently-active experiment). 



• Automatic cleanup of workflow working directories (removal of temporary files; can be disabled). 
• Button to open workflow working directory. 
• More improvements to the robustness of the workflow code. 
• Added menu item to view the MASH Explorer log file. 
• Fixed a bug in MSPathFinderT support (which caused some versions of MSPathFinderT to not work 

with MASH Explorer). 
• Support for TopFD MS1 and MS2 s/n ratios. 
• Support for fixed and variable mods in pTop 1.2. 
• Color of status bar changed for better readability of messages. 
• Minor improvements to MASH Explorer logging. 

 
MASH Explorer 2.0.2                                                                       August 24, 2020 

Version 2.0.2 fixes a bug in the usage reporting introduced in version 2.0.1.  This bug could potentially expose 
file paths when reporting exceptions. 
 

MASH Explorer 2.0.1                                                                       August 17, 2020 

Version 2.0.1 introduces usage tracking and fixes a few issues found in 2.0. 

• MASH Explorer optionally reports usage data to the MASH team.  See the relevant privacy notice here: 
https://labs.wisc.edu/gelab/MASH_Explorer/doc/MASH%20Explorer%20Privacy_Notice.pdf. 

• Note that the download links for MSDeconv and MSAlign+ have changed.  The V2.0.1 installation 
guide has the correct links. 

• We fixed several workflow-related bugs. 
• We also fixed a bug that caused problems when multiple experiments are loaded. 

 

MASH Explorer 2.0                                                                          June 17, 2020 

Version 2.0 introduces new functions and provides reliability and usability improvements from Version 1.2. 
• MASH Explorer now supports opening multiple experiment files at the same time. 
• Importing a data file can be done by dragging and dropping the data file on the MASH Explorer 

software. 
• PTMs can be customized via the configuration dialog. 
• The interface has changed from Docking Windows to Split Views. 
• TopPIC up to version 1.3.3 is supported in MASH Explorer. 
• New buttons were added in the Mass List panel to display the previous or next scan that has Mass List 

entries. 
• The up/down keys change selection in the Mass List panel. 
• The x- and y-axis coordinate for the mouse location in mass spectrum and chromatogram views is 

displayed. In the mass spectrum, the m/z value and intensity value are shown. In the chromatogram, the 
time value and intensity value are displayed. 

• The “regular” and Quick Decon Workflow Managers are now unified. 
• The adjustment of the theoretical spectrum (when an ion is selected) works much better (cleared up 

abundance vs. intensity confusion). 

https://labs.wisc.edu/gelab/MASH_Explorer/doc/MASH%20Explorer%20Privacy_Notice.pdf


• The MS level of a scan can be manually specified. 
• MASH Explorer can automatically detect activation type for search. 
• Workflow folders are better-organized. 
• The configuration dialog has buttons to automatically download third-party software. 

 

MASH Explorer 1.2                                                                November 21, 2019  
Version 1.2 is the maintenance upgrade of Version 1.1. 

• There are a number of general stability and performance improvements. 
• Workflow Manager is more useable and reliable. 
• Users can now edit the parameters of queued and finished workflows, which will produce a new queued-

to-run workflow. 
• Ion assignments can now be filtered in the mass list using context menus by right-clicking the Ion 

column header. 
• Zoom out functionality has been improved. Clicking the “zoom out” button multiple times will 

eventually show the full spectrum, even if the user has selected an ion from the Mass List. 
 

MASH Explorer 1.1                                                          August 28, 2019  

Version 1.1 is the maintenance release for Version 1.0. 
• The Mass List has been re-worked. The Mass List is now displayed as table format. 

• Stability has been significantly improved. 

• A major bug in Version 1.0 for Mass List was fixed. In Version 1.0, the mass list refreshed every time an 

entry was edited. 

• Stability of Workflow Manager has been improved. 

• Users can now upload old workflows in Workflow Manager and use the tree view to import related 

deconvolution and database search result files. 

 

MASH Explorer 1.0                                            July 2, 2019  

• A chromatogram scan can now be selected by double-clicking in the chromatogram view.  
• Quick Decon now runs via a workflow, like "normal" deconvolution/search.  (The old, non-workflow 

based Quick Decon is (temporarily) available via the Tools menu.)  

• Quick deconvolution algorithm can now be any deconvolution algorithm that the user selects. This 

option is saved with the Quick deconvolution default parameters.  

• Deconvolution results are automatically imported into the Mass List following completion of the run.  
• Database search results are automatically imported into the Protein Search Results list following 

completion of the run.    

• Citations have been added in the About dialog.  



• Sample data is included with MASH Explorer installation.   
• Configuration files to save user preferences are now available.  
• The Ion Finder now displays a theoretical fit over the zoomed-in area.  

• Calculate Fit button calculates theoretical scores for selected rows in the Mass List.  • Maintenance 

updates   

  

MASH Explorer 0.2.1                             April 15, 2019  

• Users can now set MASH Explorer configurations in Configuration dialog under Tools menu item.  
• Quick deconvolution algorithm and default parameters can be set within the Process Wizard (allows use 

of algorithms other than eTHRASH; and more control over the deconvolution parameters).  Quick 

Deconvolution now runs as a workflow within the Workflow Manager.  

o The previous quick deconvolution function is still available (though deprecated) – via the Tools 

menu.  

• Waters *.raw files can now be processed within MASH Explorer.  
• pParseTD/pTop have been re-enabled. 
• ProMex/MSPathFinderT have been re-enabled. 
• Workflow Directories are now saved within a “MASH_Workflows” sub-folder within the folder 

containing the relevant data.  This reduces clutter in the data folder.   

• The Default Output Directory now contains deconvolution and/or search algorithm name.  
• All log file entries now have timestamps.  
• MASH Explorer log file and configuration file are now stored in the user’s 

"AppData\Local\MASH_Explorer\MASH_Explorer_LogBook.txt" folder. • Maintenance updates   

  

MASH Explorer 0.2                                            March 11, 2019  

• Beta-version is released to enthusiastic users for testing.   
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